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2 testo 6610 probe

2.1 Specifications

2.1.1 Functions and use

The plug-in, adjusted probes from the testo 6610 range are used in
conjunction with the testo 6681 humidity transmitter.

These measuring units are suitable for the following applications, for
example:

Process instrumentation

Clean rooms

Test benches

Drying processes

Production and storage air quality
Complex room climate applications.

2111 Digital probes:

The probes are adjusted in the factory and transmit their adjustment data to
the internal memory of the testo 6681 transmitter. The information is
transmitted between the probe and transmitter in a purely digital form. The
probes can therefore be disconnected from the transmitter for adjustment or
servicing while the transmitter itself can remain at the measuring point.

Hint:

@ We recommend in this case that a probe of the same type be
inserted into the transmitter immediately in order to be able to
continue measuring with minimal interruption.

The transmitter identifies the probe and records that a probe was connected
in the history.

The testo 6681 transmitter cannot be run with the testo 6600
@ probes; testo 6610 probes must be used.
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21.1.2 The Testo humidity sensor

With the Testo humidity sensor, which has been in successful use and
continually improved for more than ten years, the focus has from the very
beginning been on both accuracy parameters, namely measuring uncertainty
and long-term stability.

The capacitive humidity sensor is in principle a plate capacitor consisting of
two electrically conductive plates (electrodes (1) and (2), see diagram below)
opposite each other.

A humidity-sensitive polymer (5) serves as the dielectric. The special feature
lies in the perfect way the individual layers are matched to each other. This is
evident particularly in the top electrode, which has to perform two tasks that,
at first glance, appear contradictory: it must be completely permeable to the
water vapour that is to be fed into the polymer dielectric, but at the same time
it must be impervious, smooth and repellent to condensate, oil and dirt in
order to protect the sensor.

1 Cover electrode
2 Bottom electrode

3 Substrate
(Ceramic substrate for
mechanical protection)
4  Connections
(protected against
corrosion)

5 Dielectric layer

The humidity sensor may not be damaged or touched.
Contamination and damage lead to an impairment of the
measurement and the measuring accuracy.

@ The humidity sensor cannot be exchanged by the customer.

21.1.3 Self-diagnosis

The probes in the testo 6610 range monitor their functionality themselves and
report the following faults:

Sensor breaks
Sensor short-circuit
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Condensation

The condensation message is issued at a reading of 100 % RH and
deactivated once the readings are within the valid range.

Error message with drift at the adjustment points

Value for relative humidity less than 0 % RH.
The trigger threshold is set at -2 % RH. This means that an error
message is only issued once a clear effect is discernible.

Early warning when sensor corrosion is starting to develop
The testo 6617 probe is able to signal the first signs of corrosion. The
probe can thus be changed at an early stage without interrupting the
machine availability.

Self-adjustment (testo 6615 only)

Excess temperature
Error message if the permissible process temperature is exceeded

2.1.2 Design of the probe

The probes of the testo 6610 range are made up of the following components
(included in delivery):

Probe connector
Probe shaft with protection cap and sensors (% RH and °C or °F)
Mounting bracket (for testo 6612 duct version)

Probe cable (testo 6612 to 6617 duct and cable version), bend radius
minimum @ 50 mm

Probe length
A

Probe connector S
—_— Probe
N

— e Y

[ 1D >

K Protection cap, sensor unde@

Probe
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2.1.3 Accessories

The following accessories are available for probes in the testo 6610 range:

Filters and protection caps (see chapter 2.2.1.4, Filters, page 103)

Calibration certificates according to ISO and DAKKS (see chapter 4.2,
Accessories and spare parts, page 167).

2.2 Product description

2.2.1 Overview of probe and filter types

2211 Probe version

A detailed description of the probe versions can be found
@ from chapter 2.2.2, page 104 onwards.

The following probe versions are available for the testo 6681 humidity
transmitter:

Version Article no. Characteristic

testo 6611 0555 6610-L11  Wall probe version; accuracy to + 1 % RH;
temperature range -20 °C to +70 °C/-4 to +158 °F,
sensor plugged

testo 6612 0555 6610-L12 Duct probe version; accuracy to = 1 % RH,;
temperature range -30 °C to +150 °C/-22 to +302
°F, sensor soldered/optionally plugged

testo 6613 0555 6610-L13 Cable probe version; accuracy to + 1 % RH;
temperature range -70 °C to +180 °C/-94 to
+356 °F, sensor soldered/optionally plugged

testo 6614 0555 6610-L14 Heated cable probe version; accuracy to + 1 % RH;
temperature range -40 °C to +180 °C/

-40 to +356 °F, sensor soldered

testo 6615 0555 6610-L15 Trace humidity cable probe version;
accuracy + 6 K at -60 °Ctd; temperature range -40
°C to +120 °C/-40 to +248 °F, sensor soldered

testo 6617 0555 6610-L17 Cable with cover electrode monitoring probe
version; accuracy + 1.2 % RH; temperature range -
40 °C to +180 °C/-40 to +356 °F, sensor soldered
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2.21.2 Determining the accuracy/measuring uncertainty

The entries for the measuring uncertainty for the probe are determined in
accordance with GUM (Guide to the Expression of Uncertainty in
Measurement/DIN V ENV 13005). All parts that make up the measuring
uncertainty given by Testo are listed below. When comparing the measuring
uncertainty/accuracy between manufacturers, which components are
included is to be taken into account. In many cases, not all elements that
contribute to measuring uncertainty are assessed, for example if the error
contribution of the production adjustment is shown separately or not at all.

The measuring uncertainty of the probe includes the sensor and its
electronics as well as the output of the digital measuring signal:

1. Linearity including scatter Systematic error and scattering of the
components (due to manufacturing
tolerances)

2. Hysteresis Hysteresis indicates the maximum
deviation of the readings that are
obtained when you set the same value for
the parameter, once coming from a
smaller value, once coming from a larger
value (humidity sensors actually have no
hysteresis, but rather very slow
adjustment effects that appear to be
hysteresis when considered only for a
short period.)

3. Reproducibility Repeatability (scattering of the readings
in the event of the same parameter being
entered successively)

4. Production adjustment area The measuring uncertainty of the
reference instruments of the adjustment
area (including the reference instrument)
in production

5. Uncertainty of the testing Uncertainty of the procedure for
determining points 1 and 2.
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2.21.3 Ordering options for testo 6610 probes (0555 6610)

Order code Characteristic
Lxx Probe type

L11 Probe 6611

L12 Probe 6612

L13 Probe 6613

L 14 Probe 6614

L15 Probe 6615

L17 Probe 6617

Mxx Protective filter

M 01 Stainless steel sintered filter

M 02 Metal wire protection cap

M 03 Sintered PTFE filter

M 04 Open metal protection cap

M 05 ABS plastic cap (open)

M 06 PTFE filter with drip hole

M 07 PTFE filter with drip hole and condensation protector

M 08 Filter for H,O, atmospheres

Nxx Cable length

N 00 Without cable (testo 6611)

N 01 1 m cable length (testo 6613, 6614, 6615, 6617)

N 02 2 m cable length (testo 6613, 6614, 6615, 6617)

N 05 5 m cable length (testo 6613, 6614, 6615, 6617)

N 10 10 m cable length (testo 6613, 6614, 6615, 6617)

Pxx Probe length

P 07 Probe length approx. 70 mm (testo 6611)

P12 Probe length approx. 120 mm (testo 6613)

P 20 Probe length approx. 200 mm (testo 6611, 6612, 6613, 6614, 6615,
6617)

P 30 Probe length approx. 300 mm (testo 6612, 6613, 6614)

P 50 Probe length approx. 500 mm (testo 6612, 6613, 6614, 6615, 6617)

P 80 Probe length approx. 800 mm (testo 6612, 6613)
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2214 Filters

One of the following filters or protection caps can be used for each probe
version:

Filter* Article no.* Characteristic Length A (mm)
M 01 0554 0647 Stainless steel sintered filter 33
M 02 0554 0757 Metal wire protection cap 40,3
M 03 0554 0759 Sintered PTFE filter 35
M 04 0554 0755 Open metal protection cap 35
M05 0192 0265 Open ABS plastic cap 25
M06 0554 9913 PTFE filter with drip hole 35
M 07 0554 9913 + PTFE filter with drip hole and 35
0554 0166 condensation protector 55
M08 0554 6000 Filter for H,O, atmospheres 35

*

When ordering the probe, please use this filter code, cf. chapter 2.2.1.3, Ordering
options for testo 6610 probes (0555 6610), page 102.

When purchasing a replacement (filters only), please use this order number

*k
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2.2.2 testo 6611 wall probe

The wireless testo 6611 probe is inserted into the testo 6681 humidity
transmitter that is mounted on the wall and ready-wired.

At a glance

1 Filter (including: humidity
and temperature sensor)

2 Probe shaft

3 Key

4  Connector

Application
Monitoring and regulating the production and storage air quality when
manufacturing and storing hygroscopic products
Meeting the top accuracy requirements
Clean room applications for which a metal housing is required.

©

testo 6681 transmitter

o 0000

w | w @ testo 6611 wall probe




Technical Data

Parameters

Humidity (% RH/°Ctd/°Ftd), etc.
Temperature

Measuring range

Humidity: 0to 100 % RH'

Temperature: -20to 70 °C/-4 to
+158 °F

Material

Probe shaft: Stainless steel
Connector: ABS plastic

Accuracy (at 25 °C/77 °F)*

Length 200 mm

Humidity

% (1.0 % RH + 0.007 x reading) for 0
to 90 % RH

+ (1.4 % RH + 0.007 x reading) for 90
to 100 % RH

0.02 % RH/K, dependent upon the
process temperature
(with a deviation of 25 °C/+77 °F)

0.02 % RH/K, dependent upon the
electronics temperature
(with a deviation of 25 °C/+77 °F)

Temperature

+0.15 °C (0.27 °F)

with slope PT1000 class AA

*  Refer to the charts below for the
correlation between temperature
and accuracy.

Length 70 mm

As with length of 200 mm, but with

additional measuring error, specified

for the operating mode 2 channels at

12 mA, without display light, relay off:

Humidity: +-1.6 % RH (additional)

Temperature: +-0.6 °C (1.1 °F)

in addition

" For constant use in high humidity (> 80% rF at < 30°C for
>12h, >60% rF at > 30°C for > 12 h), please contact us via
www.testo.com/service-contact

testo 6610 - 2.2 Product description

Reproducibility

Better than 0.2 % RH
Sensor

Response time without protective
filter: t 90 max. 15 sec.

Probe dimensions

Diameter of probe shaft: 12 mm
E =55mm

L = approx. 70 mm or 200 mm
L—-A=35mmor 165 mm

A, see Table Filters, chapter 2.2.1.4,
page 103.

105



106 | testo 6610- 2.2 Product description

Measuring accuracy of testo 6611 wall probe

Humidity error according to amount |+% RH| as a factor of process humidity

% RH —— 6611,6612,6613, 6622, 6623 ‘

3.0 q

0 10 20 30 40 50 60 70 80 90 100
% RH

Temperature error as a factor of process temperature and temperature of
electronics

6

05

System error 6681 + probe, electronics 25 °C/+77 °F
m— System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
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2.2.3 testo 6612 duct probe

The testo 6612 probe measures the humidity and temperature in air ducts.

At a glance

Filter (including: humidity
and temperature sensor)
2  Probe shaft

3 Wall/duct holder
(accessories,
Order no.: 0554 6651)

4 Mounting bracket
(permanently joined to
probe shaft)

Probe cable
Key
7  Connector

[e20Nd)}

In the event of overpressures, the probe may become a
projectile.

For assembly, see Pressure resistance on the following
page.

Application

Monitoring and regulating the production and storage air quality in air ducts
when manufacturing and storing hygroscopic products
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Meeting the top accuracy requirements
Air duct applications for which a metal housing is required.

testo 6681 transmitter testo 6612 duct probe
' >
L-A A
L
Technical Data
Parameters 0.02 % RH/K, dependent upon the
- o o rocess temperature
Humidity (% RH/*Ctd/Ftd), etc. (with & deviation of 25 “C/+77 °F)
Temperature 0.02 % RH/K, dependent upon the
M i electronics temperature
Hea‘:'_"f'g ra"geo R (with a deviation of 25 °C/+77 °F)
Tuml Ity-’t :;?) t +1;O °C/-22 Temperature
emperature: - (o} - o 0
to +302 °F +0.15 °C (0.27 °F)
M lal Slope PT1000 class AA
ateria . *  Refer to the charts below for the
Probe shaft: Stainless steel correlation between temperature
Line: Sheathed, FEP and accuracy.
Connector: ABS plastic Reproducibility
Accuracy (at 25°C/77°F)* Better than 0,2 % RH
Humidity Sensor
o .
* (:609(?(!2';; 0.007 x reading) for 0 Response time without protective

+ (1.4 % RH + 0.007 x reading) for 90 filter: £ 90 max. 15 sec.

to 100 % RH

2 For constant use in high humidity (> 80% rF at < 30°C for
>12h, >60% rF at > 30°C for > 12 h), please contact us via
www.testo.com/service-contact



Probe dimensions

Diameter of probe shaft: 12 mm

L = approx. 200/300/500/800 mm

L — A = 165/265/465/765 mm

A, see Table Filters, chapter 2.2.1.4,
page 103.

Cable length incl. probe shaft and
filter

testo 6610 - 2.2 Product description

Customized for duct version

Pressure resistance

PN 10 (probe tip)**

**  If installing probe under pressure,
please use cutting ring screw

connection (order no. 0554 1795).

Measuring accuracy of testo 6612 duct probe

Humidity error according to amount |+% RH| as a factor of process

humidity

— 6611,6612,6613, 6622, 6623

% RH
30

25

20

00

P SRS S e R SO T —

80 20 100
% RH
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Temperature error as a factor of process temperature and temperature of
electronics

o
W

40 4o 20 40 0 1p 20 3Jp 4p 50 60 T 80 90 100 110 120 130 130 150

System error 6681 + probe, electronics 25 °C/+77 °F
m— System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
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2.2.4 testo 6613 cable probe

The testo 6613 probe is used when the spatial separation of the transmitter
and probe is required.

At a glance
1 4 5
' I >
Connector
Key
Probe cable

Probe shaft
Filter (including: humidity
and temperature sensor)

a b oON -

In the event of overpressures, the probe may become a
projectile.

For assembly, see Pressure resistance on the following
page.

Application
Monitoring and regulating industrial humidity processes (apart from high-
humidity processes), e.g. food production, storing fruit

Monitoring the production and storage air quality when manufacturing and
storing hygroscopic products

Meeting the top accuracy requirements
Clean room applications
Applications for which a sturdy metal housing is required.
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We recommend that the testo 6614 (heated) probe be used
@ for continuous high-humidity processes.
testo 6681 transmitter testo 6613 cable probe
:[] I
o 0000 L-A A
° L

Technical Data

Parameters 0.02 % RH/K, dependent upon the
- S S rocess temperature
Humidity (% RH/°Ctd/°Ftd), etc. (with & deviation of 25 “C/+77 °F)
Temperature 0.02 % RH/K, dependent upon the
M i electronics temperature
casuring range - (with a deviation of 25 °C/+77 °F)
Humidity: 0to 100 % RH T t
Temperature: -70 to +180°C/-94 to emperature
TReRE +0.15 °C (0.27 °F)
M ial Slope PT1000 class AA
ateria . *  Refer to the charts below for the
Probe shaft: Stainless steel correlation between temperature
Line: Sheathed, FEP and accuracy.
Connector: ABS plastic Reproducibility
Accuracy (at 25 °C/77 °F)* Better than +0,2 % RH
Humidity Sensor
* (2609%’ ol/:jl_é; 0.007 x reading) for 0 Response time without protective

+ (1.4 % RH + 0.007 x reading) for 90 filter: £ 90 max. 15 sec.

to 100 % RH

3 For constant use in high humidity (> 80% rF at < 30°C for
>12h, >60% rF at > 30°C for > 12 h), please contact us via
www.testo.com/service-contact
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Probe dimensions 1/2/5/10 m

Pressure resistance**

Diameter of probe shaft: 12 mm

L = approx. 120/200/300/500/800 mm PN 10 (probe tip)
L — A = 85/165/265/465/765 mm PN 1 (if end of probe/cable is involved
A, see Table Filters, chapter 2.2.1.4, o n p!’ oces;)
page 103. If installing probe under pressure,
. please use cutting ring screw
Elr't:?e length incl. probe shaft and connection (order no. 0554 1795).

Measuring accuracy of testo 6613 cable probe

Humidity error according to amount |£% RH| as a factor of process humidity

—— 6611,6612, 6613, 6622,6623
% RH ‘

30

25

20 : : : : =

0 10 20 30 40 50 60 70 80 90 100
% RH
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Temperature error as a factor of process temperature and temperature of

electronics
05
05
"--...‘__. L “-—-
‘-q.-_-'——"
b2 I

System error 6681 + probe, electronics 25 °C/+77 °F
m— System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
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2.2.5 testo 6614 heated cable probe

The testo 6614 heatable probe is suitable for use in high-humidity processes
in which there is the possibility of condensation for the probe.

Please also see volume 1, chapter 1.3.3.5, page 35 for the
@ functional principle of the testo 6614.
At a glance
1 4 5

Connector

Key

Probe cable

Probe shaft

Filter (including:

humidity and

temperature sensor)

6 Cable for temperature
probe

7  Temperature probe

8 Condensation protection

(0554 0166/

0554 0117)

a b~ wON -~

In the event of overpressures, the probe may become a
projectile.

For assembly, see Pressure resistance on the following
page.

Application
Monitoring and regulating high-humidity processes, e.g. drying (ceramics,
tobacco, wood, food) and maturing (cheese, fruit). ).

At flow velocities > 1 m/s, an additional measuring uncertainty, not higher
than +1.5 % RH, is to be expected. To prevent this error and ensure



116 | testo 6610- 2.2 Product description

the highest measuring accuracy: Use condensation protector 0554

0166.

testo 6681 transmitter

testo 6614 heated cable probe

! D A
L-A A
L
Assembly
distance
max. 10 cm
L

Technical Data

Parameters

Humidity (% RH/°Ctd/°Ftd), etc.
Temperature

Measuring range

Humidity: 0to 100 % RH

Temperature: - 40 to +180 °C/-40
to +356 °F

Material

Temperature probe

Temperature
+0.15 °C (0.27 °F)
Slope PT1000 class AA

*  Refer to the charts below for the
correlation between temperature
and accuracy.

Reproducibility

Probe shaft: Stainless steel
Line: Sheathed, FEP
Connector: ABS plastic

Accuracy (at 25 °C/77 °F)*

Better than +0,2 % RH
Sensor

Response time without protective
filter: t 90 max. 15 sec.

Probe dimensions

Humidity (values valid when used with
Condensation protector 0554 0166)
+ (1.0 % RH + 0.007 x reading) for 0
to 100 % RH
0.02 % RH/K, dependent upon the
process temperature
(with a deviation of 25 °C/+77 °F)
0.02 % RH/K, dependent upon the
electronics temperature
(with a deviation of 25 °C/+77 °F)

Diameter of probe shaft: 12 mm

Diameter of temp. probe: 3 mm

L = approx. 200/500 mm

L — A =165/465 mm

A, see Table Filters, chapter 2.2.1.4,
page 103.

Probe length incl. probe shaft and
filter

1/2/5/10 m
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- . .
Pressure resistance** If installing probe under pressure,

please use cutting ring screw

PN 10 (probe tip) connection (order no. 0554 1795).

PN 1 (if end of probe/cable is involved
in process)

Measuring accuracy of heated testo 6614 cable probe

Humidity error according to amount |£% RH| as a factor of process humidity

— 14
% RH | 56 ‘

30

25 1--

0 10 20 30 40 50 60 70 80 90 100
% RH

Temperature error as a factor of process temperature and temperature of
electronics

KMo o g0 -0 10 2p 3p 4p 50 60 70 8P 90 100 110 120 130 140 150 160 170 180

System error 6681 + probe, electronics 25 °C/+77 °F
m— System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
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2.2.6 testo 6615 trace humidity cable probe
(self-adjustment)

The testo 6615 probe corrects deviations in measurements by means of self-
adjustment. This has a particular significance with low humidity values (in
dewpoint range).

i

At a glance

Please also see volume 1, chapter 1.3.3.6, page 37 for the
functional principle of the testo 6615.

Only use testo 6615 with sintered PTFE filter (art. no.
0554 0759) or sintered stainless steel filter (art. no.
0554 0647).

During the self-adjustment phase the signal values of the
analog outputs remain on hold, meaning they are frozen for
the duration.

] [ [ >

Connector

Key

Probe cable

Probe shaft

Filter (including: humidity
and temperature sensor)

a b wWwN =

3

In the event of overpressures, the probe may become a
projectile.

For assembly, see Pressure resistance on the following
page.



Application
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Monitoring and regulating trace humidity processes (compressed air with
adsorption or membrane driers and plastic granulate driers)

Used when spatial separation of transmitter and probe is required.

testo 6681 transmitter

Technical Data

Parameters

testo 6615 trace humidity cable probe

Dewpoint (°Ctd/°Ftd), etc.
Temperature

Measuring range

Accuracy (at 25 °C/77 °F)*

Dewpoint: - 60 to + 30 °Ctd/-148 to
+212 °Ftd

Temperature:

to +248 °F
(Temp. durability up to +180 °C/+356
OF)

Material

-40to +120 °C, -40

Probe shaft: Stainless steel
Line: Sheathed, FEP
Connector: ABS plastic

Dewpoint

+ 1 K bei 0 °Ctd/+32 ° Ftd
+ 2 K bei -40 °Ctd/- 40 ° Ftd
* 4 K bei -50 °Ctd/-58 ° Ftd
* 6 K bei -60 °Ctd/-76 ° Ftd

Dependency on process temperature
(Deviation from 25 °C/77 °F)

+ 0,1 Ktf/K at -40 °C...25 °C/
-40 °F..+77 °F

+ 0,2 Ktf/K at 25 °C...50 °C/
77 °F..+122 °F

- 0,4 Ktf/Kat 50 °C...120 °C/
+122 ° F..+248 °F

Temperature
+0.15 °C (0.27 °F)
Slope PT100 class AA

* Refer to the charts below for the
correlation between temperature
and accuracy.
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Reproducibility

Better than +0,2 % RH

Sensor

Cable length incl. probe shaft and
filter

Response time without protective
filter: t 90 max. 15 sec.

Probe dimensions

1/2/5/10 m

Pressure resistance

Diameter of probe shaft: 12 mm
L = approx. 200/500 mm
L — A = 165/465 mm

A, see Table Filters, chapter 2.2.1.4,
page 103.

PN 16 (probe tip)**

**  If installing probe under pressure,
please use cutting ring screw
connection (order no. 0554 1795).

Measuring accuracy of testo 6615 trace humidity cable probe

Dewpoint error numerically |£%RH| dependent on the process dewpoint

an
°Ctd
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Temperature error as a factor of process temperature and temperature of
electronics

System error 6681 + probe, electronics 25 °C/+77 °F
m— System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
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2.2.7 testo 6617 cable probe (self-monitoring)

The testo 6617 probe is used if spatial separation of the transmitter and
probe is required, particularly for media (gases, vapours) which can
jeopardize/damage the humidity sensor (the testo 6617 has a self-monitoring
and early-warning function for such applications).

At a glance

1 4 5

Stecker
Taste
Fihlerkabel
Sondenrohr

Filter (darunter: Feuchte-
und Temperatursensor)

a b~ oON -

In the event of overpressures, the probe may become a
projectile.

For assembly, see Pressure resistance on the following
page.
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Application
Monitoring and regulating industrial humidity processes involving corrosive
media (apart from high-humidity processes) with the exception of
applications with HCL, HF and other acids and acidifiers in larger
concentrations (SO,, SO3, NO,)
Meeting the top accuracy requirements
Applications for which a sturdy metal housing is required.

aggressive media than the testo 6613, for example. However,
early warning of damage to the sensor is given so that
machine failures can be avoided.

@ This probe does NOT have a longer life with exposure to

2271  Self-monitoring of cover electrode

Use in harsh ambient conditions with aggressive media in some cases incurs
the risk of damage to the sensor.

Damage to the sensor is generally reflected by incorrect readings which
occur a long time before the sensor is wrecked. If this damage to the sensor
is not spotted until too late, high costs can be incurred due to unusable
readings or machine shutdowns and waiting times until the sensor is
replaced.

1  Cover electrode
Bottom electrode

3  Substrate
(Ceramic substrate for
mechanical protection)
4  Connections
(protected against
corrosion)

5 Dielectric layer

N

The testo 6617 has a unique self-monitoring function. This allows early
detection of damage to the sensor, e.g.:

Mechanical damage (e.g. scratches)

Damage from aggressive gases (e.g. acids in aerosol form)

Welling or detachment of polymer layer due to effects of solvents.
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Once the self-monitoring reaches the specific limit value, the probe warning

message "Sensor early warning" is issued.

testo 668‘r transmitter testo 6617 cable probe (self-monitoring)
:[] T
9 OO0O L-A A
0 L

Technical Data

Parameters
Humidity (% RH/°Ctd/°Ftd)
Temperature

Measuring range

Humidity: 0to 100 % RH*

Temperature: - 40 to +180 °C/-40
to +356 °F

Material, weight

Probe shaft: Stainless steel

Line: Sheathed, FEP

Connector: ABS plastic

Accuracy (at 25 °C/77 °F)*

Humidity

+ (1.2 % RH + 0.007 x reading) for 0
to 90 % RH

+ (1.6 % RH + 0.007 x reading) for 90
to 100 % RH

4 For constant use in high humidity (> 80% rF at < 30°C for
>12h, >60% rF at > 30°C for > 12 h), please contact us via
www.testo.com/service-contact

0.02 % RH/K, dependent upon the
process temperature
(with a deviation of 25 °C/+77 °F)

0.02 % RH/K, dependent upon the
electronics temperature
(with a deviation of 25 °C/+77 °F)

Temperature
+0.15 °C (0.27 °F)
Slope PT1000 class AA

*  Refer to the charts below for the
correlation between temperature
and accuracy.

Reproducibility

Better than £0,2 % RH
Sensor

Response time without protective
filter: t 90 max. 15 sec.

Probe dimensions

Diameter of probe shaft: 12 mm
L = approx. 200/500 mm
L — A = 165/465 mm

A, see Table Filters, chapter 2.2.1.4,
page 103.
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Probe length incl. probe shaft and PN 10 (probe tip)**
filter ** |f installing probe under pressure,
1/2/5/10 m please use cutting ring screw

Pressure resistance

Measuring accuracy of testo 6617 cable probe (self-monitoring)

Humidity error according to amount |£% RH| as a factor of process humidity

connection (order no. 0554 1795).

—6617 ‘
% RH

3.0

0 10 20 30 40 50 60 70 80 90 100
% RH

Temperature error as a factor of process temperature and temperature of
electronics
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System error 6681 + probe, electronics 25 °C/+77 °F
— System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
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2.3 Commissioning

2.3.1 Installing the probe
2.3.11 Installing the testo 6611 wall probe

The testo 6611 probe (wall version) simply has to be inserted into the socket
of the testo 6681 transmitter.
2.3.1.2 Installing the testo 6612 duct probe

A description of the duct mounting of the testo 6612 probe can be found in
volume 1, chapter 1.3.2.2, page 24.

2.3.1.3 Installing testo 6613/6614/6615/6617 probes

If used with these probes, the testo 6681 transmitter is mounted
on the wall, see volume 1, chapter 1.3.2.1, page 22
Commissioning.

Install probe according to the application and the measuring and
spatial conditions, cf. cases A1 to C below

In processes with which condensate forms at the humidity
@ probe, install the probe vertically (filter points downwards).

A1 Wall mounting of probe

Wall/duct holder
Order no. 0554 6651
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A 2 Wall mounting of testo 6614 heated probe

When mounting the testo 6614 heated probe version, the temperature
probe must be secured as close to the humidity probe as possible (max. 10
cm). An appropriate assembly tool is supplied with the testo 6614.

Wall/duct holder
Order no. 0554 6651

testo 6614

Distance of probe tips of
humidity probe - temperature
probe: As close as possible, but
without touching (Distance
between probe tips max. 10 cm)

Assembly tool, supplied with
wall/duct holder
Order no. 0554 6651

Temperature probe
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B1 Duct mounting of probe
‘ Engage transmitter in the holder on the

end of the duct probe

Hole & 12.5 mm

Wall/duct holder
max. 70 mm Order no. 0554 6651

Only atmospheric processes up to approx. 1 bar positive pressure.
Alternatively, the single-hole duct holder (order no. 0554 1793) can also be
used.
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B 2 Duct mounting of testo 6614 heated probe

When mounting the testo 6614 heated probe version, the temperature
probe must also secured at a distance of approximately 10 cm from the
humidity probe. An appropriate assembly tool is supplied with the

testo 6614.

testo 6614
] [[
A Wall/duct holder
Order no. 0554 6651
approx. 10
Direction of flow

Assembly tool, supplied with
wall/duct holder
Order no. 0554 6651

Temperature probe

Process mounting

Cutting ring screw connection
Order no. 0554 1795

During installation, ensure that the probe cannot be damaged during

operation.
For the testo 6614 (heated probe version), please use the
@ cutting ring screw connection, order no. 0400 6193, to
assemble the temperature probe.
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2.3.2 Connecting/removing the probe to/from
the transmitter

Insert probe connector into socket of testo 6681 until it engages. The

testo 6681 identifies which probe is connected.
To remove the probe, the lock release button on the probe must be

pressed so that this can be removed.
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2.4 Maintenance and cleaning

2.4.1 Replacing filters/protection caps

2411 Replacing the filter/protection cap for testo 6611
wall version

Do not damage the sensors when exchanging the filter/the
protection cap and do not touch their surfaces!

1 Unscrew defective filter/protection cap (2) from probe shaft (1).
2 Screw new filter/protection cap onto probe shaft.

Screw on protection cap by hand, i.e. do not tighten it using a
tool.
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241.2 Replacing the filter/protection cap for testo 6612
duct version

"

23 4 56
] s
7 8
9
T
ol &
Do not damage the sensors when exchanging the filter/the
@ protection cap and do not touch their surfaces!
Hint:
@ Mark the insertion length of the probe shaft near the screw
(9).

1 Undo screw (9) and pull shaft probe (7) together with filter/protection cap
(8) from the wall/duct holder (5).

2 Unscrew defective filter/protection cap from probe shaft and screw on
new filter/protection cap.

@ Screw on protection cap by hand, i.e. do not tighten it using a
tool.

3 Replace O-ring (6) if necessary. Push probe shaft into duct as far as the
marking and fix position with screw (9).
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241.3 Replacing the filter/protection cap for cable

versions
The following descriptions applies to these probes:
@ testo 6613
testo 6614
testo 6615
testo 6617
I I 1 >
o _O000 ‘ ‘
5 &
1 2
g
Do not damage the sensor when exchanging the filter/the
@ protection cap and do not touch its surface!

1 Unscrew defective filter/protection cap (2) from probe shaft (1).
2 Screw new filter/protection cap onto probe shaft.
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@ Screw on protection cap by hand, i.e. do not tighten it using a
tool.

2.4.2 Cleaning the instrument and
filter/protection cap

Only clean the instrument carefully with a moist cloth.
Do not use aggressive cleaning agents.
Do not use any solvents.

Unscrew cap or protection cap to clean, clean with compressed air and
replace. Take care not to damage the sensor!

2.4.3 Replacing the sensor

Thanks to the probe concept (digital, plug-in), all probes can be changed in
situ within seconds if necessary, generally without any interruption to the
operation of the machine.

To maintain the extremely high accuracy of the testo 6610
@ probe, customers are not able to replace the sensor.

Please contact your Testo Service team for this.



P2A software - 3.1 Specifications

3 Parameterizing,
adjusting and analyzing
software (P2A software)

3.1 Specifications

The P2A software is used for the parameterizing, adjustment and analysis of
testo transmitters. The following applies:

. Generally, all newer testo transmitters (as of 2007) are supported.

. For each newly purchased Testo transmitter, a free software upgrade
must be installed, containing the instrument drivers for all transmitters
which are connectable at that time.

. This upgrade can be downloaded free of charge at any time from the
Testo homepage www.testo.com/download-center (requires
registration).

The software must only be bought one time, even for owners of several testo
transmitters.

3.1.1 Functions and use

In the P2A software, two different file types are used: The instrument and the
parameter file.

Instrument file

The parameters of a particular transmitter are stored in its so-called
instrument file. Using this file, the parameters can be edited and the
instrument can be tested and adjusted.

Instrument files also contain the respective histories in addition to the
parameter data, i.e. "log books" are kept for the previous parameterizations,
adjustments and messages (see chapter 3.3.5, page 160).

@ Instrument files are ".cfm" format files.
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Parameter file

Parameter files are not tied to a specific individual transmitter and contain
only parameter data/no history data.

If you use various instruments of the same type, you can create parameter
files once (e.g. by saving the appropriate instrument file as the parameter file)
and transmit these onto the other instruments.

@ Parameter files are ".cfp" format files.

3.1.2 System requirements
Operating system

«  Windows® XP Home/Professional SP3

+  Windows® Vista

+  Windows® 7

. Computer

. The computer must fulfil the requirements of the respective operating
system. The following requirements must additionally be fulfilled:

« Interface USB 1.1 or higher
. Graphic resolution min. 1024 x 768

i Date and time settings are automatically taken over from
the computer. The administrator must ensure that the
system time is regularly synchronized with a reliable time
source, in order to guarantee the authenticity of the data.

Software

The P2A software must be purchased and installed separately from the
transmitter. If it is a new software version, the transmitter is already
supported completely. Older P2A software versions can be updated via the
P2A software upgrade (cf. product CD included with the transmitter).
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3.1.3 Scope of delivery
Included in the scope of delivery are:

P2A software
USB driver

When working with the parameterizing, adjusting and
@ analyzing software (P2A software), previous knowledge of

Windows® operating systems is assumed.

The description in this instruction manual relates to

Windows® XP.

3.2 First steps

3.2.1 Installing the software/driver
@ Adminstrator rights are required for installation.

3.211 Installing P2A software
1 Insert CD with P2A software.
If the installation program does not start automatically:

Open Windows Explorer and start the file Setup.exe on the software CD.
2 Follow the directions of the installation assistant.

3.21.2 Installing USB driver

Before installing the USB driver, please read the separate
@ documentation that is enclosed with the USB driver CD.
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3.21.3 P2A software upgrade

1. Download and store P2A software upgrade from
www.testo.com/download-center (requires registration).

2. Select folder into which the downloaded Zip file was stored,
and unzip the file.

3. Start file P2A upgrade.exe.
4. Follow instructions from installation assistant.

3.2.2 Starting the software

3.2.2.1 Starting the program

> Click on [Start] | Programs (Windows XP) or All Programs
(Windows Vista, Windows 7) | Testo | P2A- Software.

i In Windows Vista/Windows 7 the window User
account control is opened when starting the
software the first time.

> Click on Accept.
The program window is opened (see chapter 3.3.1, page 139).

3.2.2.2 Establishing a connection with the instrument
Multiple instruments can be attached, however only one connection is active
at all times.

v USB driver is installed (see chapter 3.2.1, page 137).

1 Start the P2A software.

2 Connect adapter (supplied with the P2A software) to the service
interface of the instrument (see volume 1, chapter 1.2.4, page 15).

3 Connect instrument/adapter to the PC via the USB interface.
The instrument file of the attached instrument is shown in the file list.

3.2.2.3 Activating the connection with the instrument
Click on the desired instrument file.

The selected file is marked in colour and the connection with the
instrument is activated.

If a connection with the instrument is established when the program is
started, the corresponding instrument file is marked automatically.
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3.3 Using the software
3.3.1

# Testo - P24 - Software

User interface

1 ——== ven top

2 — =i sle| 9]

[E——] =10l x|

Bl ) P2A Software

%

|

Change parameterization

Test/analyze transmitter

Adjust transmitter =¢

Transmitet history

il

testo BE31
SN 01218682
Fw 075

6 —wa—

1

testo BE11
PSN 0218074

Communication Ok
1

[T

Menu bar:
Menu

File

Edit

View

Command

Open

Save as

Copy

Paste

Toolbar
Status bar

Explanation

Shows the Windows dialogue for searching and
opening files.

Saves the parameters of an instrument or
parameter file under a new name.

Copies the parameters of the marked instrument
or parameter file in the cache.

Pastes the parameters from the cache in the
marked instrument or parameter file.

Activates/deactivates the toolbar or status bar.
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Menu Command Explanation
? Check Checks the connections to a connected
instrument instrument without the instrument having to be

connections  activated.

Service A text file with the most important information on
the computer and the software is opened via
Display service data.

About Shows the version number of the P2A software.
2 Toolbar:
Shows the Windows-compliant icons for editing.
3  File list:
Icon File Explanation
| Instrument  Instrument file
bl file Connection to the instrument has been established.
<Type> <Serial number>.cfm
File name should not be changed.
ﬁ__j Instrument  Instrument file
bl file Connection to the instrument has not been
established.
"B Parameter <Type> <Serial number> <Date> <Time>.cfp
- file File name can be changed.

The name can be selected freely, but it is
recommended that you retain the reference to the
instrument.

Parameter files are always marked red; the parameter
values they contain are only forwarded to the
instrument after being transmitted to the instrument
file.

4 Function buttons:
[Change parameterization] see chapter 3.3.2, page 141
[Test/analyze transmitter] see chapter 3.3.3, page 150
[Adjust transmitter] see chapter 3.3.4, page 155
[Transmitter history] see chapter 3.3.5, page 160

Dialogues on editing and testing the instrument are opened by means of
the buttons.




5

6

3.3.2

3.3.2.1
v

1

File information:

If an instrument file is
selected

If a parameter file is
selected

Connection status

Status bar:

P2A software - 3.3 Using the software

Shown in the window

Type, serial number, firmware version of the
instrument or probe.

Type, serial number and firmware version of
instrument for which the parameter file was
created.

Green = connection is active,
Red = connection is inactive.

Shows the current status when editing via the menu bar.

Editing instrument/parameter file

Changing instrument/parameter file
The desired instrument/parameter file is marked.

Click on [Change parameterization].

The Properties of <Instrument type> <Serial number> dialogue is
opened with the Change parameterization register.

If the parameters were transmitted from other parameter files into the
instrument file, a message is shown with which you can transmit the
new parameters to the connected instrument using [Yes].

If the parameters should not be transmitted, click on [No].

Change or enter parameters in the corresponding fields.

141



142 | P2A software - 3.3 Using the software

Unit/analog Explanation
output All analog outputs are parameterized in this mask.
E
Changing the parameterization |
f Urit/analog output Chanrel 1
= . ——
" \a;llr:;t:a\ues e [ ‘
[»] Relay 2 v @
HEIJS 100- ’ - — -
Relay 4 g Rl
E gaswlc settings o g
£ Display 00- - -
T =3
20 :Il 70 :Il
Seale minimLm Seale maximum E@
Analog signal delay lindependent of reaction time. e.g. 130 of sensor]
Signal delay testo 661
[Stage 1 - 15] SN 01218682
lg_ﬂ Pw/ 0.75
testo 6611
PSM 01218074
Communication DK
 ———
aK I Cancel Apply
Unit/analog Unit: 0to 1 V/5V/10 V or 4 to 20 mA.
output. Vertical: Current version of the analog output (cannot be
(graphic) changed).
Horizontal: Min./max. scale end points of selected unit.
The curve changes in accordance with the entered value
of scale minimum and maximum.
Scale The endpoints of the scaling can be selected up to the
minimum/ stored scale minimum and maximum. In the process,
maximum scaling can take place beyond the measuring range in

order to adjust the analog output to the customer system,
see volume 1, chapter 1.2.8, page 17.
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Field Explanation

Unit Selection of the physical unit.
When changing the unit, standard values are set for scale
minimum and maximum (see transmitter instruction
manual for the scale final values).
Caution!

When changing the phys. unit, the relay limit values are
set to the assigned default values.

Signal delay Curve changes according to the set signal delay.
(graphic)

Signal delay Time interval in stages of 1 to 15:
1 =no delay
15 = longest delay.
The signal delay is added to the reaction time of the
sensor. The signal delay shows averaging over the time
interval of the selected stage in seconds:
Example

Stage 10 = average of the readings from the last 10
seconds.

the process is also significantly influenced by the

@ The delay of the signal in relation to the change in
selection of the particle filter.
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Relay limit Explanation

values 1 to 4

In this mask, the relays or display alarms are
parameterized

Only have the transmitter wired and connected by
authorized personnel with the voltage disconnected.

testo 6661 01218682 Properties ﬂ
Changing the parameterization |
i Unit/analog output Relay 1
& Channel 1
&= Channel 2 ) Mt used & MIN monitaring —
1%y e'a;;"f:: 1"5"‘93 " Collective alam MK moritoting - ‘
Relay 2 r-,
E Py 3 ll“ ..DQ‘
Relay 4 ’ -
= slc seilngs Hysteresis Bt T
L Display Uit
«—>
OH
Charnel A E@
jv
A J
OFF
g _Unit
testo BEB1
SN 01218682
Limit value hies
testo BE11
PSN 01218074
Communication OK
]
[ ok | Concel Aoply
Relay x Four relays are available (optional).
Not used Relay is not used.
Hysteresis image and input options are hidden.
Collective A relay can be used as a collective alarm detector in the
alarm event that selected messages appear. See below for

MIN monitoring

selection of the messages.

If switched to ON (NO contact) or OFF (NC contact) under
the limit value; in the event of a subsequent exceeding of
limit value plus hysteresis, it is switched to OFF (NO
contact) or ON (NC contact).
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Field Explanation
MAX If switched to ON (NO contact) or OFF (NC contact)
monitoring above the limit value; in the event of a subsequent
undershooting of limit value minus hysteresis, it is
switched to OFF (NO contact) or ON (NC contact).
The graphic display in the centre of the screen refers
to the relay wiring as a NO contact (ON).
Hysteresis To avoid switching cycles.
Channel Selection of the channel that is to be monitored.
Limit value Values for the limits of the unit selected in Unit/analog
output; 1 decimal place.
When changing the phys. unit, the relay limit values are
set to the default values.
Collective Explanation
alarm Selection of the messages (error, etc.) that should result
in a collective alarm (OR linkage).
rocto oot oizrosszmoperies |
Changing the parameterization |
W Relsy 1
whper | Glaman o M
- I n
-k e g
Hpse srocio o

Ernon messages/ealy narmings
[ T ambient high
[ T ambient low
[ Supply valtage low
7] alchdog error
[T Analog out adiust

& Fiobes
Stotus messages
[ 1-point adjustment testo 681
[ 2-point adjustment 11.3 % N 01218832
™ 1-paint adjustment 75.3 % Fw 075
[ Analog out adfjust
I Sel-adustment active (nur bei Filrler testo 6615) testo BE11
[ Sencor tehiesh active [nur bei Filer testo 6515 PSN 01218074
3 Probe et Communication 0K
Erior messages/eally warnings
[ 2-pairt adfustment drit | e——
Cancel Apply

List field with
checkboxes

Selection of which messages generated in the
transmitter should be signalled as the collective alarm
via the corresponding relay.
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Basic settings Explanation

Setting the absolute pressure and selection of the H,O-
evaporation process for the parameter °Ctm.

testo 6661 01218662 Properties i x|

Changing the paramelzrization |

S Urit/analog output

== Channel 1
== Channel 2

e
e
u’ﬂgﬂelaylllval“es Absolute Pressure 10130 [WPa = -
Jasic settings
seoe
||Q >
RLUSE L
By

Bas
[LE Display

H202 proces
& yia H202 water

" using evaporated H202

Hzo2 00 it ezﬂ

testo BE81
SN 01218682
Pw 075

testa 6611
PSM 01218074

Communication 0K

[ ok | Cancel Apply

Absolute The absolute pressure is included in the calculation of the
pressure following units:

- °Cuga Or °Figa

- g/kgor gr/lb

- ppmv/% vol.

H202 process The calculation of the mixture dewpoint unit °Ctm is

dependent upon the type of the evaporation process:

- with passive vaporization: H.O, solution evaporates (=
via H,O; water)

- with active vaporization: H,O2 solution is evaporated
over a heated metal plate (= with evaporated H205)

- Input field: Entering the weight proportion of the liquid
H20, compared to water in %.
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Display Explanation

Setting the display functions (if a display is available on
the transmitter).

testo 6661 01218682 Properties

B Unit/analog output

== Channel 1 o
== Channel 2 st

Flelay limit values i

g Basic settings -
E =
: 8

=

Foron 5]

Continuous Display lighting is permanently switched on.
display lighting

Display lighting When a particular button on the instrument is pressed, the
when button is  display lights up for 10 seconds.
pressed (10

seconds)

Display Setting the brightness between 0 and 9:
brightness (0 0 = dark

to 9) 9 = light.

Display Setting the contrast between 0 and 9:
contrast 0 = lower contrast

(0to9) 9 = higher contrast.



Field

Display
language

New password

Adopt new
password

Valid password
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Explanation

Selection of the language.

The password consists of four numbers, each of which
must be between 1 and 9.

If the password protection is not to be used, the numerical

code "0000" must be entered.

Button for confirming the new password.

Display of the current password.

Self- Explanation
adjustment Parameterizing of testo 6615 probe, if this is used. (See
volume 1, chapter 1.3.3.6, page 37 and 2.2.6, page 118).
x|
Changing the parameterization |
i Unit/analog output
iy Relay limit values
#F Basic setfings -‘-E_\_’
=] D:sp\ayt Ewucﬁetgnn fiodustner ogeine e meba it e
[5 ] Self-adistment " © @0oe
> (
L
g
¥ Activate ssli-adjustment for the testa 6615 probe:
Self-adjustment every:
E0 Hour
testo GEE1
SN 1218682
Pw 0.75
testo 6615
PSN 01218074
Communication 0K
——
0 || Cacd | borb |

Activate self-
adjustment

Perform adjustment of testo 6615 probe (auto-correction).
The automatic self-adjustment is switched on, which
means the probe performs an offset adjustment every x
hours. The frequency is given in hours.
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Self- Setting the cycletime in which the self-adjustment is
adjustment to be performed
every
In order to receive reliable readings during
the calibration or equalization period of the
probe, testo recommends the shortest
possible cycle time.
A longer cycle time can be set in continous
operation.
Start self- Start self adjustment at a defined time outside the

adjustment cycle time.
Click on [Apply].

Changes are saved.

3.3.2.2 Saving parameters
Parameters can be saved in new parameter files.

1

2
3
4

Mark instrument/parameter file

Click on File > Save as in the menu bar.
Select storage location and enter the file name.

Click on [Save].
The new parameter file is shown in the file list.

Only the parameters are saved from an instrument file, the history data
are not adopted.

suggested with the current date/time as standard, e.g.

@ The original name (Instrument type, Serial number) is

"testo 6681 01234578 061120 1403.cfp".

For a standard installation, the files are saved under
"C:\Documents and Settings\All Users\Shared
Documents\P2A Software". The path can differ depending on
the version of the operating system.

3.3.2.3 Open parameter file

All parameter files stored in the standard directory path are automatically
displayed in the file list when the software is started.

You can also open parameter files that are stored in other directories.
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1 Click on File > Open in the menu bar.
2 Select the storage location and click on the requisite file.
3 Click on [Open].
The selected file is opened. This can be changed and saved (see
chapter 3.3.2.2, page 149).
3.3.2.4 Copying and pasting parameters
The parameters of a parameter file can be transmitted to an instrument file or
another parameter file from the same instrument type.
1 Select file whose parameters are to be copied.
2 Click on Edit > Copy in the menu bar.
3 Select the file which is to be modified.

4 Click on Edit > Paste in the menu bar.

The parameters are transmitted to the file.

copying and pasting, i.e. CTRL C and CTRL V.

Parameters can also be transmitted using drag & drop, where
you drag the icon of the parameter file onto the icon of the
target instrument file.

@ You can also use the common keyboard shortcuts for

3.3.2.5 Deleting instrument/parameter file
Instrument/parameter files can be deleted from the file list.

1 Click on the file that is to be deleted with the right mouse button.
2 Select the command Delete in the context menu.
The instrument or parameter file is deleted from the list.

3.3.3 Analyzing/testing the transmitter

In this section, you can test the outputs of the connected instrument, read off
the limit values and reset the parameters to the factory settings.

The function is only available for instrument files.

3.3.3.1  Analyzing/testing the instrument
v The required instrument file is marked.

1 Click on [Test/analyze transmitter].
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The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

Perform action:

Action Explanation

Carry out factory  Reset the unit, limit value and hysteresis parameters to
reset: factory settings (see chapter 3.3.3.2, page 151)

Test analog Test channel 1/2/3 (optional) (see chapter 3.3.3.3, page
output: 1517).

Test switch Manually switch relays 1 to 4 to test for proper function

outputs: (see chapter 3.3.3.3, page 151).

Min./max. values  Overview of the minimum and maximum values
display: measured since the last reset of the transmitter (see
chapter 3.3.3.4, page 153).

Click on [OK] or [Cancel] to close the dialogue.

3.3.3.2 Carry out factory reset

v
1

The required instrument file is marked.

Click on [Test/analyze transmitter].

The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

Mark Transmitter test.
Current operating hours are shown.

Confirm control query to perform the reset.
The values are reset to the customer-specific factory settings.

Click on [OK] or [Cancel] to close the dialogue.

3.3.3.3 Testing channel 1/2/3 analog output

v
1

The required instrument file is marked.

Click on [Test/analyze transmitter].

The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

Mark channel and test values.

151



152 | P2A software - 3.3 Using the software

Field/button Explanation

Checking the analog outputs (see volume 1, chapter
1.4.6.6, page 78).

=
Analpzingtesting the bransmitier |
S Transmitter tests
&= Channel 2 i =~
[ Relay tests =
¥ Min/max. valuss View reading |
BTy
Current reading 132 T A"" ‘
RL SR L o
2 g3
Analog output test
Default value: 00 . e
Activate Deactivate
testo 6631
SN 218682
Pw 0.75
testo BE15
PSM 01218074
Communication 0K
—
aK I Cancel Apply
Current Readings are updated every second.
reading
Unit Unit according to the type of analog output.

Default value Freely definable output value for the respective type of
analog output (V or mA), 1 decimal place.

[Activate] The entered default value is forwarded to the
corresponding analog output and to the test contacts by
clicking.

A warning informs that the value is being transmitted to
the connected instrument in the event of existing cabling.

Now check the analog output using a precise multimeter.

[Deactivate] Finish entering the electrical variables at the analog
output.

The analog output returns to the Current reading again.

3 Click on [OK] or [Cancel] to close the dialogue.
The analog output returns to Measuring Mode again.
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3.3.3.4 Testing switch output relays 1 to 4
v The required instrument file is marked.
1 Click on [Test/analyze transmitter].

The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

2 Mark Relay tests and test the values.

Field/button Explanation
Check the relay function (see volume 1, chapter 1.4.6.6,

page 78).
B
Analyzingdtesting the tansmilter |
[ Transmitter tests
& Channel 1 I
& Channel 2 fl A
ey iy tests elay outputs
6 Min /max. valuss |
Activate 1elay 1 Deactivals telay 1 ‘ L © @ooe
e
Activate relay 2 Deactivate 1oy 2 uyg
Activale 1elay 3 Deaclivale relay 3
e
Activale 1elay 4 Deaclivale relay 4
testo GE81
SN 01218682
Fw 075
testo 6615
PSN 01218074
Communication 0K
——
[ ok | Concel Aol

[Activate relay  Close contact.

n] A warning informs that the value is being transmitted to a
connected PLC, external display, etc. in the event of
existing cabling.

[Deactivate Open contact.

relay n] A warning informs that the value is being transmitted to a

connected PLC, external display, etc. in the event of
existing cabling.

3 Click on [OK] or [Cancel] to close the dialogue.
The analog output returns to Measuring Mode again.
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3.3.3.5 Displaying min./max. values

The transmitter saves the minimum or maximum value for each channel
(measured since the last voltage supply or since the last manual reset).

v The required instrument file is marked.

1 Click on [Test/analyze transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

2 Mark Min./max. values.

Field/button Explanation
View the min./max. values of each channel.

x|
Analyzing/testing the tansmitter |
[ Tiansmitter tests
== Charnel 1 —
&= Channel 2 - g —=
B Helay tests Channel [ Vale [ Unit
g i /vl Channel 1 min 0.0 T
Channel 1 max. 14.3 ‘C X -T-Y
Channel 2 min. 0.0 T { & 2
Channel 2 max. 143 T Py ‘
TR
| | >
Plasst the Min/bas valuss | st
SN 218682
Fuw 0.75
testo BE15
PSN 01218074
Communication 0K
=e=e---
ak I Cancel Anply
Channel Min./max. of channel 1/2/3 (optional)
Value Min. or max. value, 1 decimal place.

Unit Unit selected in Unit/analog output.
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Reset Min./max. values.

4 Click on [Reset the min./max. values].
5 Confirm control query to perform the reset.
The values are reset to the default settings.

5 Click on [OK] or [Cancel] to close the dialogue.

3.3.4 Adjusting the transmitter

This function is used to adjust an attached instrument. The following
adjustments may be carried out using the software:

1-point adjustment (offset)

2-point adjustment (upper and lower adjustment point)

Analog adjustment (entry via assistant/wizard).

Also see volume 1, chapter 1.3.3, page 25 for this.
3.3.41 1-point adjustment

The testo 400/650 with precision humidity probe (order no.

@ 0636 9741) is recommended as the reference measuring
instrument for 1-point adjustment (offset) (see volume 1,
chapter 1.3.3.2, page 29).

1 Expose the reference measuring instrument and the instrument to be
adjusted to the same constant conditions and wait for equalization
period to lapse.

2 Mark the instrument file of the connected instrument.
3 Click on [Adjusting the transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Adjusting the transmitter register.
4 Enter reference value and click on [Carry out 1-point adjustment].
5 Confirm confirmation request
The adjustment is carried out.
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Field

testo 6681 01218682 Properties

1-point adjustment
mperature
|t 2-paint adjustment
1.3%
753%
Ry Analog adjustment
== Channel 1
== Channel 2

°CIF

Current
reading

Reference
value

Explanation

Selection of the unit; only for temperature adjustment.

Reading in °C/°F or % RH.
Readings are updated every second.

Entry of the read-off value from the reference measuring
instrument.

Permissible entries:
max. 5 % RH deviation
max. 2 K (°C) deviation

Click on [Set offset to zero] to reset a transmitted reference value.
The current reading is used again.

6 Click on [OK] or [Cancel] to close the dialogue.
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3.34.2 2-point adjustment
@ Also see volume 1, chapter 1.3.3.3, page 31.

1 Expose the reference measuring instrument and the instrument to be
adjusted to the same constant conditions and wait for equalization
period to lapse.

2 Mark the instrument file of the connected instrument.

3 Click on [Adjusting the transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Adjusting the transmitter register.

4 Mark 11.3 %, enter the reference value for the lower adjustment point
and click on [Lower adjustment point].
The adjustment is carried out.

5 Mark 75.3 %, enter the reference value for the upper adjustment point
and click on [Upper adjustment point].
The adjustment is carried out.
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Field Explanation

testo 6681 01218682 Properties

1-point adjustment

Huridity

Temperature
|t 2-point adjustment

1.3%

Py Analog adiustment
&= Channel 1
&= Channel 2

Current Reading in % RH.

reading Readings are updated every second.

Reference Entry of the read-off value from the reference measuring
value instrument.

Permissible entries:
Lower adjustment point 10.3 to 12.3 % RH
Upper adjustment point 74.3 to 76.3 % RH.

6 Click on [OK] or [Cancel] to close the dialogue.
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3.3.4.3 Adjusting the analog output

1 Connect precision multimeter (see volume 1, chapter 1.3.3.4, page
34).

2 Mark the instrument file of the connected instrument.

3 Click on [Adjusting the transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Adjusting the transmitter register.

4 Click on [Start wizard...] and follow the instructions of the wizard.
The adjustment is performed when the wizard is closed.

Field Explanation

Analog outputs adjustment x|

. Precise multimeter required

Chaninel 1
Lower analog adustment point

7%

Measured analog value (precise multimeter required):

[

Entry imperativel

< Back I Mext > I Cancel

Default value The analog output value is given at the output:
Lower adjustment point: 10 % of the max. value
Centre adjustment point: ~ 50% of the max. value
Upper adjustment point: 90 % of the max. value.

Measured Required field:
analog value Entry of the value read off at the multimeter.
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3.3.5 Transmitter history

Parameterizations, adjustment processes and messages that have occurred
are registered in the transmitter with an operating hours stamp.

In the history overviews (explained later in more detail), past processes and
events can be made visible.

directly at the instrument (via the user menu), "Transmitter" is
entered in the User field and only the operating hour is
entered in the Date/time field instead of operating
hour/date/time.

@ For parameter changes or adjustments that are performed

For entries that are performed using the P2A software, the
name of the user logged into Windows appears in the User
field, while the operating hour is shown in the Date/time field.

1 Mark the instrument file of the connected instrument.

2 Click on [Transmitter history] button.
The "Properties of <Instrument type> <Serial number>" dialogue is
opened with the Transmitter history register.

3 Click on the required entry in the list to change the display.
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Parameteri- Explanation
zation history

testo 6661 01218662 Properties ] x|

Transmiter history |

% Z:":g:fﬂ”f:‘tz:”:jw Parameterization history

(Z) 1-peint adjustments

5] 2-peint adjustments z T

Z] Anson sdustmerts

X Enor/status messages
[l User settings charged
[ Rislay dota were charged
il User seftings charged
il Ulser settings charged
i Patsmetetizstion was changed
2 Patsmstetization wias channed
2 Patsmstetizstion was channed
T2 Patsmstetizstion was channed
T2 Poatsmstetization was channed
2 Poatsmtetization wss channed
2 Fislay dota were chargsd
2 Rislay dota were charged
T2 Patsmtetizstion wiss changed
T2 Patsmstetization was channed
2 Poatsmtetization was channed
2 Patsmstetization was channed
52 Patsmstetization was channed
T2 Patsmstetization wias channed
T2 Fislay dota were chargsd
%2 Rislay dota were chargsd
T2 Rislay dota were charged
T2 Fislsu dote were chiariosd =
Setwppinter. | Piint |

ot ] comee | o |

Date/time Format of the PC time is adopted from the settings of the
operating system.

User Name with which the user is logged into the operating
system.
"MUF" (= transmitter) if the change was performed at the
instrument.

Operating Operating hour/time stamp at which the change at the

hours/date/time instrument was performed.

Comments Type of parameter change,
e.g. "Unit of channel 2 from °F to °C".
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Adjustment Explanation
histories
restasoa1 niziasazpmoperties X
Transmitter history |
E] Parameterization history 5 et q
il ifustment bistris History 1-point adjustments
(&) 1-point adjustments
(3] 2poit adustrments Operaling hou/Date/Time | User Seriaino. Frobe | Ficference... | Actua... | Unit | Offset.. | Offset...
] Anslog adiustments 185 23/10/2007 10:51:19  Administistor | 1218074 40.00 3889 ZH 0.00 1.11

FX Eror/status messages

Selwppinter.. | Piint |

ok || Cancel | ap |

Selection: 1-point adjustments/2-point adjustments/Analog

adjustments.

Date/time Format of the PC time is adopted from the settings of the
operating system.

User Name with which the user is logged into the operating
system.
"MUF" (= transmitter) if the change was performed at the
instrument.

Operating Operating hour/time stamp at which the change at the

hours/date/tim  instrument was performed.

e

Serial no. Serial number of the probe.

Probe

Reference If no changes were performed, no value is displayed.

value



Column
Unit

Actual value
before
adjustment

Offset from

Offset to

Offset

Channel
Specification
Reading
Offset
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Explanation
Unit during the adjustment.
1-point adjustment: If no changes were performed, no

value is displayed.

1-point adjustment: Value before the adjustment.

1-point adjustment: Value after the adjustment.

2-point adjustment: Difference between target and actual
value reported by instrument.

Analog adjustment: Channel 1 to n.
Analog adjustment: Actual value.
Analog adjustment: Reference value entered.

Analog adjustment: Deviation at time of adjustment.
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Error/status Explanation

messages
5

Transmitter history |

[§] Parameterization history Errorfstatus messages

|| Adiustment historiss

(&) 1-point adiustments
(3] 2point adiustments | [T 5 ang hour | Wser [ Message [ Tspe of message =l

5] Anslog adiustments 53 MUF Probe discornected Error messages/ealy wamings

FX Errar/status messages 93 MUF Probe connection Status messanes
53 MUF Probe disconnected Error messages/eatly warings
53 MUF Probe disconnected Eror messages/eatly warnings
53 MUF Probe cannection Status messages
93 MUF Probe disconnected Error messages/eatly warings
93 MUF Probe disconnected Error messages/eatly warnings
53 MUF Probe connection Status messages
53 MUF Probe dissonnected Eror messages/eatly warings
53 MUF Probe connection Status messages
53 MUF No probe signal Eror messages/eatly warings
34 MUF Sel-adustment active [n__| Status messages
34 MUF Probe reset Status messages
% MUF Sel-adjustment active [n__| Status messages
% MUF Probe reset Status messages
97 MUF Sel-adjustment active [ | Status messages
97 MUF Piobe reset Status messages
% MUF Sel-adjustment active [n__| Status messages
% MUF Piobe reset Status messages
5 MUF Sel-adjustment active [n._| Status messages
EE] MUF Probe reset Status messages
100 MUF Probe cannection Status messages
101 MUF Probe disconnected Eror messages/eatly warings
101 MUF Piohe connection Status messanes |

Selwppinter. | Piint |
ok || Cancel | ap |

The table is shown only for error and status messages that were generated
in the transmitter and were transferred and saved there via the connection
to the P2A software.

Date/time Format of the PC time is adopted from the settings of the
operating system.

Operating Operating hour at which the message appeared in the

hours instrument.

User "MUF" (= transmitter) because the message was
generated in the transmitter.

Message e.g. "Wrong probe". A non-compatible probe was
connected.

Type of e.g. early warning, status message.

message

To print out the history data, click on [Print].
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The printing job is automatically sent to the default printer for
@ the operating system.

The printout can be edited using [Set up printer...].

4 Click on [OK] or [Cancel] to close the dialogue.
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4 Tips and assistance

4.1 Questions and answers

Question

Possible causes/solutions

Connection to instrument cannot be
established

Check connection cable/plug contacts

A message appears on the display

See volume 1, chapter 1.5, page 84.

Malfunction (with or without display)

Analysis using the P2A software, see
chapter 3.3.3, page 150.

Undo adjustment

A 1-point temperature/humidity adjustment
can be reset to the current reading using
[Set offset to zero].

The actual values before the adjustment
can be read out from the corresponding
history table.

2-point adjustments and analog
adjustments can only be undone by means
of a factory reset.

When does a stable current reading
appear?

After approx. 20 seconds

If we could not answer your question, please contact your dealer or Testo
Customer Service. For contact data, see back of this document or web page

www.testo.com/service-contact.
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4.2 Accessories and spare parts

An overview of the probes that can be used with the
@ testo 6681 can be found in volume 1, chapter 1.2.2, page 14.
Designation Article no.
Interface and software
P2A software (parameterizing, adjusting, analyzing) incl. USB 0554 6020
adapter
testo 400/650 adapter 0554 6022
Fastenings, assembly aids
Wall/duct bracket with M3 screw for fastening the transmitter to the 0554 6651
probe and the probe to the wall/duct
Single-hole plastic duct screw connection 0554 1793
Duct screw connection (aluminium/PVC) 0554 1794
Pressure-tight G 1/2" screw connection with cutting ring up to 16 bar 0554 1795
Pressure-tight G 1/2" screw connection with PTFE ring up to 6 bar 0554 1796
Stainless steel flange for screw connections in accordance with DIN 0554 1797
2576
Plug-in connections
Set of M12 plug-in connections (connector and socket) for power 0554 6682
and signal lines
Profibus
Profibus connector and Profibus socket 0554 6683
Profibus expansion module (Profibus DP interface) 0554 6686
Profibus T-piece 0554 6687

Profibus terminating resistor 0554 6688
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Designation Article no.

Dewpoint measurement (only with testo 6615)

Pre-filter for the protection of the measurement chamber and sensor 0554 3311
from contamination

Precision chamber for adjustable flow impact 0554 3312
Through-flow gauge for the measurement chamber, for adjusting the 0554 3313

specified flow impact onto the sensor

Sensor filters and protective caps

Stainless steel sintered filter 0554 0647
Wire mesh filter 0554 0757
Sintered PTFE filter 0554 0759
Protection cap made of metal (open) 0554 0755
PTFE protection cap with drip hole 0554 9913
Condensation protector 0554 0166
Filter for H202 atmospheres 0554 6000
H202 protection cap 0699 5867/1
Adjustment equipment

Humidity adjustment set (11.3/75.3 % RH) 0554 0660
Reference set (testo 650, 1 % RH probe with certificate) 0699 3556/15
Control and adjustment set for wood moisture (testo 6614) 0554 0662
é\gg)ustment adapter (for 1-point adjustment with testo 400 or testo 0554 6022
Extension and adjustment cable 0554 6610
Supply

Mains unit (desktop, wall-mounted) 0554 1748
Mains unit (top-hat rail mounting) 0554 1749
External display

Prozess display testo 54-2 AC.... 5400 7553
Prozess display testo 54-7 AC.... 5400 7555
Calibration

Standard ISO calibration certificate, transmitter only 0520 1000
Standard DAKKS calibration certificate, transmitter only 0520 1200
Standard ISO calibration certificate, transmitter + probes 0520 0176

Special ISO calibration certificate, transmitter + probes 0520 0066
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Designation Article no.
Standard DAKKS calibration certificate, transmitter + probes 0520 0276
Special DAKKS calibration certificate, transmitter + probes 0520 0236
ISO- calibration certificate humidity, probes 0520 0076

DAKKS calibration certificate temperature, probes 0520 0261
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4.2.1 Ordering options for testo 6681 transmitter

(0555 6681)
Order code Characteristic
Axx
Version
AO01 Currently no further selection of variants
Bxx Analog
output
B02 0to 1V (4-wire, 24 VAC/DC)
BO3 0to 5V (4-wire, 24 VAC/DC)
B04 0to 10 V (4-wire, 24 VAC/DC)
BO5 0 to 20 mA (4-wire, 24 VAC/DC)
B06 4 to 20 mA (4-wire, 24 VAC/DC)
B77 Profibus-DP
Cxx
Display
Ccoo without display
Cco2 with display/English
Co3 with display/German
co4 with display/French
Co05 with display/Spanish
Co6 with display/Italian
co7 with display/Japanese
Dxx Cable entry
D01 M16 PG screw connection (with relay, also M20)
D02 Cable entry NPT 1/2"
D03 Plug-in connections for power and signal lines
Fxx
Channel 1 Unit
FO1 % RH/Min/Max
F02 °C/Min/Max
FO3 °F/Min/Max
FO4 °Ctd/Min/Max
FO5 °Ftd/Min/Max
FO6 g/kg /Min/Max
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Order code Characteristic

FO7 gr/lb /Min/Max

FO8 g/m®Min/Max

F09 gr/ft/Min/Max

F10 ppmMyo/min/max

F11 °Cwp/Min/Max (wet bulb)

F12 °Fwp/Min/Max (wet bulb)

F13 kJ/kg /Min/Max (enthalpy)

F14 hPa /Min/Max (water vapour partial pressure)
F15 inch H20/Min/Max (water vapour partial pressure)
F18 % Vol / min / max

Gxx

Channel 2 Unit

GO01 % RH/Min/Max

G02 °C/Min/Max

GO03 °F/Min/Max

G04 °Ctd/Min/Max

G05 °Ftd/Min/Max

GO06 g/kg /Min/Max

GO07 gr/lb /Min/Max

G08 g/m®Min/Max

G09 gr/ft*/Min/Max

G10 ppmMye/min/max

G11 °Cwo/Min/Max (wet bulb)

G12 °Fwo/Min/Max (wet bulb)

G13 kJ/kg /Min/Max (enthalpy)

G14 hPa /Min/Max (water vapour partial pressure)
G15 inch H20/Min/Max (water vapour partial pressure)
G18 % Vol / min / max

Hxx

Relay

HOO0 without relay

HO1 4 relay outputs, limit value monitoring

HO02 4 relay outputs, channel 1 limit values and collective alarm
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Order code Characteristic

Ixx

Optional 3rd

analog output

100 no optional 3rd analog output
101 % RH/Min/Max

102 °C/Min/Max

103 °F/Min/Max

104 °Ctd/Min/Max

105 °Ftd/Min/Max

106 g/kg /Min/Max

107 gr/lb /Min/Max

108 g/m®Min/Max

109 gr/ft’/Min/Max

110 ppmMye/min/max

111 °Cwp/Min/Max (wet bulb)

112 °Fwe/Min/Max (wet bulb)

113 kJ/kg /Min/Max (enthalpy)

114 hPa /Min/Max (water vapour partial pressure)
115 inch H20/Min/Max (water vapour partial pressure)
116 °Ctm (H202 mixture dewpoint)
117 °Ftm (H202 mixture dewpoint)
118 % Vol / min / max

119 %RHm (mixture humidityfor H202)
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4.2.2 Ordering options for testo 6610 probes

(0555 6610)
Order code Characteristic
Lxx
Probe type
L11 Probe 6611
L12 Probe 6612
L13 Probe 6613
L 14 Probe 6614
L 15 Probe 6615
L17 Probe 6617
Mxx

Protective filter
M 01
M 02
M 03
M 04
M 06
M 07
M 08

Nxx
Cable length

N 00
N 01
N 02
N 05
N 10
N 23

Pxx
Probe length

P 07
P12
P 20

P 30

Stainless steel sintered filter

Metal wire protection cap

Sintered PTFE filter

Open metal protection cap

PTFE filter with drip hole

PTFE filter with drip hole and condensation protector
Filter for H202 atmospheres

Without cable (testo 6611)

1 m cable length (testo 6613, 6614, 6615, 6617)

2 m cable length (testo 6613, 6614, 6615, 6617)

5 m cable length (testo 6613, 6614, 6615, 6617)

10 m cable length (testo 6613, 6614, 6615, 6617)
Cable length specifically for duct versions (testo 6612)

Probe length approx. 70 mm (testo 6611)
Probe length approx. 120 mm (testo 6613)

Probe length approx. 200 mm (testo 6611, 6612, 6613, 6614,
6615, 6617)

Probe length approx. 300 mm (testo 6612, 6613, 6614)
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Order code Characteristic

P 50 Probe length approx. 500 mm (testo 6612, 6613, 6614, 6615,
6617)

P 80

Probe length approx. 800 mm (testo 6612, 6613)
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